The information in this document is subject to change without notice and does not represent a commitment on the part of Native Instruments GmbH. The software described by this document is subject to a License Agreement and may not be copied to other media. No part of this publication may be copied, reproduced or otherwise transmitted or recorded, for any purpose, without prior written permission by Native Instruments GmbH, hereinafter referred to as Native Instruments.

“Native Instruments”, “NI” and associated logos are (registered) trademarks of Native Instruments GmbH.

Mac, Mac OS, GarageBand, Logic, iTunes and iPod are registered trademarks of Apple Inc., registered in the U.S. and other countries.
Windows, Windows Vista and DirectSound are registered trademarks of Microsoft Corporation in the United States and/or other countries.
All other trademarks are the property of their respective owners and use of them does not imply any affiliation with or endorsement by them.

Document authored by: Adam Hanley, Jan Ola Korte
Software version: 6.0 (09/2015)
## Table of Contents

1  Welcome to REAKTOR ................................................................. 6
   1.1  System Requirements ................................................................. 7
   1.2  REAKTOR Modes: Full, Player and Demo ........................................ 7
   1.3  The REAKTOR 6 Documentation .................................................. 8
   1.4  Manual Conventions ................................................................. 12

2  Getting to Know REAKTOR .......................................................... 13
   2.1  The Interface at a Glance ............................................................. 13
   2.2  The Toolbar ................................................................................ 14
      2.2.1  Transport ........................................................................... 16
      2.2.2  Info Hints ........................................................................... 17
      2.2.3  Audio Input & Output Level Meters ........................................ 18
      2.2.4  System Info .......................................................................... 19
         2.2.4.1  Changing the Sample Rate ............................................. 19
   2.3  Play Mode vs Edit Mode ............................................................ 20
   2.4  File Types and Hierarchy .......................................................... 21

3  Setting Up REAKTOR ..................................................................... 25
   3.1  Audio Settings .......................................................................... 25
   3.2  MIDI Settings ........................................................................... 30

4  REAKTOR as a Plug-in ................................................................. 34
   4.1  Editing Ensembles and Automatic Saving ..................................... 35
   4.2  Resolving a Broken Ensemble Link ............................................. 39

5  Browsing and Loading Ensembles .................................................. 43
   5.1  The REAKTOR Browser ............................................................ 46

6  Instrument Basics .......................................................................... 53
   6.1  A/B View ................................................................................ 54
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Snapshots and Presets</td>
<td>55</td>
</tr>
<tr>
<td>7.1</td>
<td>Recalling Snapshots</td>
<td>55</td>
</tr>
<tr>
<td>7.2</td>
<td>Storing Snapshots</td>
<td>57</td>
</tr>
<tr>
<td>7.3</td>
<td>Presets</td>
<td>59</td>
</tr>
<tr>
<td>8</td>
<td>Controlling REAKTOR</td>
<td>60</td>
</tr>
<tr>
<td>8.1</td>
<td>MIDI Learn</td>
<td>60</td>
</tr>
<tr>
<td>8.2</td>
<td>Connection Manager</td>
<td>61</td>
</tr>
<tr>
<td>9</td>
<td>Getting Deeper into REAKTOR</td>
<td>70</td>
</tr>
</tbody>
</table>
1 Welcome to REAKTOR

REAKTOR is a visual programming environment based on modules and wires, allowing you to create any musical tool imaginable. Its many uses include music creation, digital art, instrument and effects building, as well as scientific applications.

REAKTOR 6 builds on a long history of legendary products, from GENERATOR to REAKTOR 5, representing the foundation of NI as a company, and as a brand—the future of sound.

Welcome to REAKTOR 6

Known for its unrivalled sound quality, REAKTOR is the complete toolkit for creating instruments and effects with high-quality DSP components. The included content allows you to look behind the curtain and explore the state-of-the-art technology at the core of many of our products.
From playing and combining pre-built instruments and effects and building your own tools with its extensive Library to creating custom DSP algorithms, REAKTOR suits musicians, builders, and programmers alike. Based on a hierarchical structure with a coherent interface, REAKTOR is optimized to facilitate all of these use cases. This means that you can approach REAKTOR level by level, making yourself familiar with its deep functionality one step at a time.

The REAKTOR 6 documentation adapts this approach, guiding you through the different levels of functionality in a clear and comprehensible manner. The Getting Started and Diving Deeper documents cover all basic functions and settings in REAKTOR, while the tutorials and instructions provided in Building in Primary and Building in Core make creating your own musical tools more accessible than ever before.

REAKTOR is fortunate to be supported by a large community of experienced users who actively share their Ensembles in the REAKTOR User Library on our website. There are thousands of REAKTOR Ensembles available, ready to be played, combined and modified—a great source of inspiration, both musically and technologically. We invite you to join this vibrant community and are looking forward to seeing and hearing your new creations!

1.1 System Requirements

Your computer system needs to meet certain requirements in order to run REAKTOR.

For the latest REAKTOR system requirements and compatibility information visit:

www.native-instruments.com/reaktor6specifications

1.2 REAKTOR Modes: Full, Player and Demo

What you can do with the REAKTOR version installed on your computer depends on which mode REAKTOR is running in. This mode depends on the license you are using:

- Full mode: If you have already installed and activated REAKTOR, as a single product or as part of a bundle like KOMPLETE, you are using it in Full mode. In Full mode, all functionality is available without restrictions.
• **Player mode:** You have installed and activated any of the KOMPLETE instruments and effects for REAKTOR and the free REAKTOR Player. In Player mode you can play Instruments and change their settings, but cannot edit their internal structure. All Instrument settings are saved with your host project when using REAKTOR as a plug-in.

• **Demo mode:** You installed REAKTOR and a number of KOMPLETE Instruments as demo versions, but did not activate any of the products yet. In this case you are using the demo license for REAKTOR, and REAKTOR is running in Demo mode. In Demo mode, you have all functionality but the application will stop generating sound after 30 minutes. Furthermore, storing is disabled.

### 1.3 The REAKTOR 6 Documentation

The REAKTOR documentation is accessible from the *Help* menu.

The documentation for REAKTOR 6 is divided into five separate documents, guiding you from loading and playing pre-built Ensembles to building your own Instruments.

• **REAKTOR 6 What Is New** is written for users who are already familiar with previous versions of REAKTOR and only describes the latest features in brief.
• **REAKTOR 6 Getting Started** is for new users. It is the only document needed for users who intend to use REAKTOR for loading and playing pre-built REAKTOR instruments and effects.

• **REAKTOR 6 Diving Deeper** expands on the concepts introduced in the Getting Started document. It provides more detail on subjects like Snapshots (REAKTOR’s preset system), and introduces advanced topics like OSC control and combining multiple Instruments in one Ensemble.

• **REAKTOR 6 Building in Primary** shows you how to build your own Instruments in REAKTOR’s Primary level. It focuses on a series of tutorials that guide you through building your first synthesizers, effects, and sequencers.

• **REAKTOR 6 Building in Core** describes the Core level of REAKTOR with its low-level building features, which can be used for implementing custom DSP algorithms. It includes reference information about the Core Macro Library, an comprehensive collection of DSP building blocks.

With the exception of the What Is New document, each of the documents listed above builds on the knowledge of the previous documents. While it is not necessary to read all of every document, some of the more advanced documents, like Building in Primary, assume knowledge from the previous documents.

**REAKTOR Content Documentation**

REAKTOR comes with a comprehensive Factory Library, including many pre-built instruments and effects, as well as Blocks, a new modular synthesizer framework that brings the experience of patching an analog modular synthesizer to REAKTOR. The manuals for this content, as well as any REAKTOR-based KOMplete instruments or effects you have installed, can be accessed from the Browser in REAKTOR’s Side Pane.

To open the manuals for REAKTOR content:
1. Click on the Browser icon in the Side Pane to open the Browser.

2. Select the Player tab.
3. Double-click on the folder of the content you wish to view the manual for.

![REAKTOR interface with Reaktor Blocks selected]

4. Select the Documentation subfolder. The manual shows up as a PDF file in the lower section of the Browser.

![REAKTOR interface with Documentation subfolder selected]

5. Double-click on the PDF file.

→ The manual will open in your standard PDF reader.
1.4 Manual Conventions

This section introduces you to the signage and text highlighting used in this manual.

- Text appearing in (drop-down) menus (such as Open…, Save as… etc.) and paths to locations on your hard disk or other storage devices is printed in *italics*.
- Text appearing elsewhere (labels of buttons, controls, text next to checkboxes etc.) is printed in **blue**. Whenever you see this formatting applied, you will find the same text appearing somewhere on the screen.
- Important names and concepts are printed in **bold**.
- References to keys on your computer’s keyboard you’ll find put in square brackets (e.g., “Press [Shift] + [Enter]”).

► Single instructions are introduced by this play button type arrow.

→ Results of actions are introduced by this smaller arrow.

An indented, gray paragraph contains additional, contextual information.

Furthermore, this manual uses particular formatting to point out special facts and to warn you of potential issues. The icons introducing these notes let you see what kind of information is to be expected:

| ![Speech Bubble] | The speech bubble icon indicates a useful tip that may often help you to solve a task more efficiently. |
| ![Exclamation Mark] | The exclamation mark icon highlights important information that is essential for the given context. |
| ![Red Cross] | The red cross icon warns you of serious issues and potential risks that require your full attention. |
2 Getting to Know REAKTOR

REAKTOR can be used in many different ways, from loading and playing pre-built Ensembles, to building new Instruments using the Modules and Macros Library, to programming your own DSP building blocks in Core. REAKTOR’s interface and file hierarchy are optimized to facilitate all these use cases, offering clear workflows for the task at hand. This section gives an overview over the interface, the Play Mode and the Edit Mode, as well as the file types used in REAKTOR.

2.1 The Interface at a Glance

REAKTOR’s interface can be divided into three main areas:
(1) **Toolbar**: The area along the top is called the Toolbar and contains a lot of REAKTOR's global options and settings (see section ↑2.2, The Toolbar).

(2) **Main area**: The main area in the center displays either the loaded Instrument Panel, the Structure of the Ensemble, or both (the area can be split with the options in the upper-right corner).

(3) **Side Pane**: The area to the left is called the Side Pane and contains a number of different functions categorized by tabs:

- Browser (see section ↑5.1, The REAKTOR Browser)
- Snapshots (see section ↑7, Snapshots and Presets)
- Connection Manager (see section ↑8.2, Connection Manager)
- Panelsets (find more information in the Diving Deeper document)
- Properties (find more information in the Diving Deeper document)

### 2.2 The Toolbar

The toolbar, located along the top of REAKTOR's interface, gives you access to many of the main options and parameters in REAKTOR.

(1) **REAKTOR icon**: Clicking on the REAKTOR icon opens a window displaying information about the software. This window can be used to find the version number of your current REAKTOR installation, which is located to the top left of the window.
(2) **Open main menu:** The arrow to the right of the REAKTOR icon opens the main menu. This contains many different options and functions which are referenced throughout the documentation.

(3) **Show Side Pane:** The magnifying glass button shows or hides the Side Pane. The Side Pane hosts a variety of functions and settings, organized in tabs. See sections ↑5.1, The REAKTOR Browser, ↑7, Snapshots and Presets, and ↑8.2, Connection Manager for more information. The Panelsets and Properties tabs are described in the Diving Deeper document.

(4) **Toggle Edit Mode:** The EDIT button toggles Edit Mode on or off. See section ↑2.3, Play Mode vs Edit Mode for more information.

(5) **Snapshot menu:** The Snapshot menu is where you can browse and load Snapshots from the loaded Ensemble. Snapshots are REAKTOR’s main sound preset type and are explored in more detail in section ↑7, Snapshots and Presets. Clicking on the Snapshot name opens the snapshot menu. The up and down arrows to the right of the menu can be used to cycle through the Snapshots.

(6) **Transport:** The transport controls are used to control the global playback. See section ↑2.2.1, Transport for more information.

(7) **Show Sample Map Editor:** The button with the waveform icon shows or hides the Sample Map Editor. This button is only available if the loaded Ensemble contains a Sampler Module. The Sample Map Editor is described in the Diving Deeper document.

(8) **Show Player and Recorder:** The button with the tape reel icon shows or hides the Player and Recorder. The Player and Recorder utilities allow you to play back and record audio files. The Player and Recorder are described in the Diving Deeper document.

(9) **Show Info Hints:** This button shows or hides the tool tip information when placing the mouse over an element in the user interface. See section ↑2.2.2, Info Hints for more information.

(10) **Audio input level meter:** The audio input level meter lets you monitor and adjust the input level for signals arriving at REAKTOR’s inputs. The audio input meter is only visible if the loaded Ensemble includes audio inputs. See section ↑2.2.3, Audio Input & Output Level Meters for more information.
(11) **MIDI/OSC input and output**: The MIDI/OSC input and output indicators light up when REAKTOR sends or receives any MIDI and OSC messages. MIDI and OSC are the main ways of controlling REAKTOR with hardware. The indicators are useful for checking if your hardware is communicating with REAKTOR. See section ↑8, Controlling REAKTOR for more information about MIDI and OSC.

(12) **Audio output level meter**: The audio output level meter lets you monitor and adjust the output level for signals sent from REAKTOR’s outputs. See section ↑2.2.3, Audio Input & Output Level Meters for more information.

(13) **System info**: The system info area contains displays and controls for the system and audio status. See section ↑2.2.4, System Info for more information.

(14) **NI icon**: Clicking on the NI icon opens a window displaying information about the software. This window can be used to find the version number of your current REAKTOR installation, which is located to the top left of the window.

### 2.2.1 Transport

Since REAKTOR can be used to create sequencers, REAKTOR has its own transport for controlling playback.

> The transport controls are not available in the plug-in version of REAKTOR since it uses the host’s transport settings.
The leftmost button resets the play position (meaning it rewinds the play head to position zero). You can also reset the play position by pressing [ctrl] + [space] (Windows) or [cmd] + [space] (OS X) on your computer keyboard.

The center button is the play button. It is used to start or pause playback. You can also start or pause playback by pressing [space] on your computer keyboard.

The value display to the right is where you can define the playback tempo in BPM (beats per minute). You can do this either by clicking and dragging the value up and down, or by double-clicking and typing in a new tempo.

### 2.2.2 Info Hints

Many of the elements in REAKTOR’s user interface show tool tip information when you place the mouse over them. This information is called an Info Hint in REAKTOR. The Info Hints can be enabled from the toolbar.

- Click on the Show Info Hints button in the toolbar to enable the Info Hints. Alternatively, press the keyboard shortcut [ctrl] + [i] (Windows) or [cmd] + [i] (OS X).
The Info Hints are now shown as soon as you place the mouse over an element in REAKTOR’S user interface.

### 2.2.3 Audio Input & Output Level Meters

The audio input and output level meters in REAKTOR

The audio input and output level meters let you monitor and adjust the level of audio signals arriving at REAKTOR’s audio inputs as well as audio signals sent from REAKTOR’s audio outputs.

- The audio input level meter is only visible if the loaded Ensemble includes audio inputs.

If the signal level is too high and the input or output is overloading, red lights will appear at the right edge of the meters.
Below each of the meters is an arrow. Clicking and dragging on the arrow sets the input or output signal level. For example, if the output of an instrument is too loud, you can lower the signal level by moving the arrow below the output meter to the left.

### 2.2.4 System Info

![The system info in REAKTOR](image)

The rightmost area in the toolbar contains the system info and controls.

- The top left display shows a measure of the CPU load in percent.
- The bottom left display shows the currently set sample rate. Clicking on it opens a drop-down menu for selecting the sample rate (see section 2.2.4.1, Changing the Sample Rate).
- The power button to the right stops and starts REAKTOR's audio engine. If the audio coming from an Ensemble cuts out unexpectedly, sometimes switching the power button off and on can fix the problem.

#### 2.2.4.1 Changing the Sample Rate

By default REAKTOR uses the sample rate of your audio interface for processing. This is also the default setting for most Ensembles. However, some Ensembles (e.g. MONARK, ROUNDS) use a higher sample rate to improve audio quality.

- Clicking on the sample rate display opens the sample rate drop-down menu.
The sample rate setting in the toolbar

The sample rate menu contains a number of entries, organized in three categories:

- **Host/System**: This entry sets REAKTOR to operate at the same sample rate as your audio interface. This is the default setting for most Ensembles.

- **Fixed**: The fixed entries are multiples of your audio interface’s sample rate. They can be saved with the Ensemble and are used to improve the audio quality. Keep in mind that higher sampling rates require more CPU.

- **Factor**: These entries allow you to reduce or increase the sample rate in the current REAKTOR session.

### 2.3 Play Mode vs Edit Mode

REAKTOR has two modes of operation:

- **Play Mode**: This mode optimizes REAKTOR for loading and playing instruments; it decreases loading times and streamlines the interface, but removes the options for deep editing of Ensembles and Instruments. This mode is especially useful when using REAKTOR in a DAW or host.
• **Edit Mode**: This mode gives you access to all of the controls and options REAKTOR has to offer, allowing you to create or edit Ensembles and Instruments.

► To toggle Edit Mode on or off, click on the **EDIT** button in REAKTOR’s toolbar.

### 2.4 File Types and Hierarchy

REAKTOR uses several distinct file types, each representing a different structural level in the application. These levels help to organize your REAKTOR projects in a meaningful way, and the corresponding files can be used to share aspects of your work between projects or with other users.

#### Ensembles

At the top level is the **Ensemble**, which holds all relevant information of a REAKTOR session. It represents the basic project file you are working with in REAKTOR. An Ensemble can contain a single instrument or a full suite of sequencers, synthesizers, and effects. Pre-built instruments and effects also come as Ensembles, ready to be used in your music or sound design projects. Ensembles are saved as *.ens files.
A REAKTOR Ensemble containing one Instrument

Information about Ensembles can be found in the Getting Started and Diving Deeper documents.

Instruments

An Instrument is a container for a synthesizer, sequencer, an effect, or any other musical tool you create, representing the so-called Primary level of REAKTOR. It includes the internal Structure, MIDI processing, Panel (user interface), and Snapshots (presets) associated with your musical tool. In order to connect an Instrument with REAKTOR’s audio inputs and outputs, it has to be loaded in an Ensemble. You can combine multiple Instruments in one Ensemble. Instruments are saved as *.ism files.
A REAKTOR Instrument containing several Macros.

Information about Instruments can be found in the Getting Started and Diving Deeper documents.

**Modules and Macros**

Instruments are created using **Modules**. These are REAKTOR's basic building blocks. Modules can be organized into containers called **Macros**. This is especially useful if your Instrument consists of a complex structure with a large number of Modules. Macros can be saved as *.mdl files.
A REAKTOR Macro containing several Modules and another Macro.

Information about Modules and Macros can be found in the Building in Primary document.

Core Cells

Core Cells are a way of creating your own DSP modules using REAKTOR’s visual programming language. Core is the most advanced level of programming in REAKTOR. Core Cells can be saved as *.rcc files.

A REAKTOR Core Cell.

Information about Core Cells can be found in the Building in Core document.
In order to be able to send and receive audio as well as interact with the REAKTOR stand-alone application, you need to configure your audio and MIDI hardware devices (i.e. audio interface, MIDI keyboard) in REAKTOR’s Audio and MIDI Settings. When using the REAKTOR plug-in, these settings are taken over by the host software. In this case, REAKTOR automatically connects with the host software in order to send and receive audio and MIDI.

When you first open the REAKTOR stand-alone application, the Audio and MIDI Settings window appears, prompting you to make the required settings:

![The Audio and MIDI Settings window](image)

### 3.1 Audio Settings

The audio settings are located in the Audio and MIDI Settings window.

- To access the audio settings, open the File menu and select *Audio and MIDI Settings*...
The first tab in the Audio and MIDI Settings window is the Audio tab, which contains the main audio preferences. This is where you select your audio interface and adjust its settings for use with REAKTOR.

The Audio tab in the Audio and MIDI Settings window

The options presented in this tab are ordered in such a way as to lead you through the audio setup process. Follow the steps below to set up your audio interface:

1. Select the type of driver you want to use from the Driver drop-down menu. On computers running Windows, using ASIO is highly recommended. On computers running OS X, Core Audio is pre-selected.
2. Select your audio interface from the Device drop-down menu. The devices available in this menu depend on your Driver type selection.
3. Check the Status of your audio interface. If the hardware is connected and working, this area shows the message Running.
4. Set the Sample Rate for your audio interface. Sample rates of 44100 and 48000 Hz are commonly used and recommended. If you are using an ASIO driver on a Windows system, click on the ASIO Config button to access the ASIO settings for your audio interface and set the sample rate.
5. Set the **Latency** for your audio interface. Latency refers to the period of time the computer needs to process an audio signal. It is determined by the size of the audio buffer (in samples). Buffer sizes of 128 and 256 samples are commonly used and recommend.

If the computer is not able to provide the amount of processing power needed to complete all audio calculations in time, crackles and drop-outs in the audio playback might occur. In this case, gradually increase the size of the audio buffer until the playback is clean.

**Setting up the Audio Routing**

After you have completed setting up your audio interface in the **Audio** tab, you can then choose which audio inputs and outputs REAKTOR should use in the **Routing** tab. This is where you connect REAKTOR’s inputs and outputs to the inputs and outputs of your audio interface.

The **Routing** tab in the Audio and MIDI Settings window

The **Routing** tab has two pages:

- **Inputs**: On this page you can manage the connection options for REAKTOR's inputs.
- **Outputs**: On this page you can manage the connection options for REAKTOR's outputs.
REAKTOR can have multiple inputs and outputs. Most of the time you will only need to use two of each (for the left and right stereo channels), but in some cases more outputs are required. For example, an Ensemble hosting multiple Instruments can benefit from individual outputs for each of them.

To set the audio inputs:

1. Click on the Inputs tab.

2. Click on the area labeled *not connected* beside the REAKTOR input you wish to define.

3. Select the input you wish to use from the menu.
To set the audio outputs:

1. Click on the Outputs tab.

2. Click on the area labeled *not connected* beside the REAKTOR output you wish to define.

3. Select the output you wish to use from the menu.
Once you have completed the Audio settings as well as the Inputs and Outputs selection process, click the OK button to confirm your settings.

### 3.2 MIDI Settings

The MIDI settings are located in the Audio and MIDI Settings window. To access the MIDI settings:

1. Open the **File** menu and select **Audio and MIDI Settings**…
2. Click on the **MIDI** tab.

   The MIDI tab contains the main MIDI preferences. This is where you enable your MIDI devices for use with REAKTOR, for example MIDI keyboards, USB MIDI controllers, or MIDI interfaces.
The MIDI tab in the Audio and MIDI Settings window

The MIDI tab has two pages:

- **Inputs**: On this page you can select the devices which REAKTOR receives MIDI data from.
- **Outputs**: On this page you can select the devices REAKTOR sends MIDI data to.

Both of these pages show similar looking tables with the same columns:

- **Device name**: This column shows a list of the MIDI devices connected to your computer.
- **Status**: This column shows the current **On/Off** state of the device.

To enable MIDI data being received from a MIDI device (for example a MIDI keyboard):

1. Click on the **Inputs** tab.
2. Click on the **Status** of the device you wish to use.

![Inputs Outputs](image)

3. Select **On** from the menu.

![Device name Status](image)

→ REAKTOR now receives MIDI data from the MIDI device.

You can test if the connection is working by sending MIDI data to REAKTOR (e.g. by pressing keys on your keyboard) and checking if the MIDI indicator in the Toolbar is blinking (see section ↑2.2, The Toolbar).

To enable MIDI data being sent to a MIDI device (for example a MIDI-controlled synthesizer):

1. Click on the **Outputs** tab.

![Inputs Outputs](image)
2. Click on the **Status** of the device you wish to use.

![Device Status](image)

3. Select **On** from the menu.

![Device Status](image)

→ REAKTOR now sends MIDI data to the MIDI device.
REAKTOR as a Plug-in

A common use case for REAKTOR is loading it as a plug-in in a host sequencer. When using the REAKTOR plug-in in a host sequencer project, you typically make changes to the Ensemble by tweaking its knobs and other Panel elements. These changes are saved as part of your host sequencer project.

The REAKTOR plug-in also stores a link to the loaded Ensemble file. When you re-load a host project, REAKTOR looks for the Ensemble file, loads it, and then applies any control changes you may have made.
By default, the REAKTOR plug-in opens in Play Mode, meaning that the Ensemble Structure and the Ensemble’s advanced settings are locked. This protects any loaded Ensemble, allowing you to use it as an instrument or effect without needing to worry about accidentally altering the Ensemble and losing the changes you may have made.

You can still enter Edit Mode in the REAKTOR plug-in and make changes to the Structure or the Ensemble’s advanced settings, but this means you will need to save and manage your Ensemble file in addition to your host sequencer project (see section ↑4.1, Editing Ensembles and Automatic Saving).

4.1 Editing Ensembles and Automatic Saving

When you are using the REAKTOR plug-in in Edit Mode and the Ensemble is modified in such way that the changes are not saved in the host sequencer’s project, the Save Ensemble button in the Toolbar turns red, indicating that these changes will be lost when closing the project:

The red Save Ensemble Button

To preserve the changes you have made, you need to create a local copy of the Ensemble. A link to this local copy is saved in the host sequencer’s project and the Ensemble will be automatically loaded the next time you open the project.

To save a local copy of the Ensemble:
1. Click on the Save Ensemble button in the Toolbar.

![Screenshot of REAKTOR interface showing the Save Ensemble button.]

2. In the file dialog, choose the desired location and name for the local copy of your Ensemble and click Save.

![Screenshot of REAKTOR interface showing the Save Ensemble As dialog box.]

A local copy of your Ensemble is saved and the Save Ensemble button turns from red to grey, indicating that all changes have been saved.

The next time the Save Ensemble button turns red to indicate that changes will be lost when closing the project, you can simply click on it to save the changes to your previously created local copy.

Enabling Automatic Saving

You can also enable automatic saving of the Ensemble. Again, a local copy of the Ensemble is created, however it is saved automatically every time you save the host sequencer’s project. This way, you do not have to keep track of the save status of the Ensemble as long as your host sequencer’s project is saved correctly.

To enable automatic saving of the Ensemble:

1. Click on the Enable Automatic Saving with Host button in the Toolbar.
2. In the file dialog, choose the desired location and name for the local copy of your Ensemble and click **Save**.

![Choose Location for Saving with Host dialog](image)

→ The Enable Automatic Saving with Host button lights up, indicating that automatic saving of your Ensemble is now enabled. The local copy of the Ensemble is saved every time you save your host sequencer’s project, and will be automatically loaded the next time you open the project.

⚠️ You can disable automatic saving by clicking on the lit Enable Automatic Saving with Host button. This resets the automatic saving, and you can click on the button again to enable automatic saving with a new local copy of your Ensemble.
4.2 Resolving a Broken Ensemble Link

Since the REAKTOR plug-in loads the Ensemble that linked in your host sequencer project from an external file, it is possible for the link to the Ensemble to become broken, for example if you rename the folder where the Ensemble is located.

If this happens, REAKTOR reports that it cannot find the linked Ensemble and asks you locate it:

REAKTOR Ensemble not found

To locate the Ensemble file and re-establish the link, follow the instructions below:

1. Click the LOCATE ENSEMBLE button.
2. In the file dialog, navigate to your Ensemble file and select it.
3. Click open to confirm your selection.
The Ensemble is loaded, and the re-established link can be saved in your host sequencer project.

Alternatively, you can click the IGNORE button to permanently break the link to the Ensemble file and start using REAKTOR from scratch.
Ensembles are the main file type used for final REAKTOR instruments and effects. There are a number of ways to browse for and load Ensemble (*.ens) files.

**Drag and Drop**

The most basic way of loading Ensemble files is via drag and drop:

1. Using your operating system's file browser, locate the file you wish to load.
2. Click on the file and drag it into REAKTOR's interface.

3. Release the mouse button.

   → REAKTOR will load the selected Ensemble.

**File Menu**

You can also open Ensembles via the main menu:

1. Click on the arrow next to the REAKTOR to open the main menu.
2. Go to the **File** menu and select **Open Ensemble**...

![Open Ensemble](image1)

3. In the file dialog, navigate to your Ensemble file and select it.

![File Dialog](image2)
4. Click open to confirm your selection.

→ REAKTOR will load the selected Ensemble.

5.1 The REAKTOR Browser

REAKTOR’s Browser is located in the Side Pane and allows you to browse for REAKTOR content, including all of your installed REAKTOR instrument and effects.

► You can display the Browser by clicking on the magnifying glass icon.

The Browser has three tabs:
• **Player**: This tab displays REAKTOR content found in specific locations on your computer that were created during the REAKTOR installation (find more information about the Directories Preferences in the Diving Deeper document). Any installed REAKTOR-based KOMPLETE instruments and effects will show up here (see below).

![Player Tab](image)

• **Library**: This tab is only visible in Edit Mode. It is where you browse for Modules and Macros when building your own Instruments (learn more about building in the Building in Primary document).

![Library Tab](image)
• **Files:** This tab consists of a file browser that is not bound to any specific location on your computer. If you just downloaded Ensembles from the REAKTOR User Library on the Native Instruments website, you can browse and load them directly using the **Files** tab.

![Files Tab](image)

**The Player Tab**

If you have installed any KOMPLETE instruments and effects that run in REAKTOR (like MONARK or THE MOUTH), then the **Player** tab is populated with folders:
The Player tab in the REAKTOR Browser

To load a file:
1. Select the folder of the instrument or effect you wish to load in the top section of the Browser; the corresponding Ensemble file is displayed in the lower section.

2. Load the Ensemble file by double-clicking on it, or drag and drop it into the main area of REAKTOR's user interface.
You can access the documentation for your KOMPLETE instruments and effects, the Factory Library, and Blocks by double-clicking on the folder and selecting the Documentation subfolder.

### User Ensembles

REAKTOR also creates a user folder during installation, into which you can place your own Ensembles, or Ensembles you have downloaded from the REAKTOR User Library.

By default, the User Ensembles folder is found in the following location:

- Macintosh HD/Users/<your user name>/Documents/Native Instruments/Reaktor 6/Ensembles/
- Windows: C:\Users\<your user name>\Documents\Native Instruments\Reaktor 6\Ensembles\

To view the User Ensembles folder in the Browser, click on the User icon at the top-right corner of the Browser.

The Browser will populate itself with the contents of the User Ensembles folder.

The top window of the Browser will display the folders, and the lower window will display the contents of any selected folder.
You can return to browsing KOMPLETE instruments and effects by clicking on the Native Instruments NI logo.
6 Instrument Basics

The Instrument Header is located at the top of the panel of any Instrument you load into REAKTOR.

(1) **A/B View**: Selects A or B view for the Instrument. See section 6.1, A/B View for more information on these controls.

(2) **Minimize**: Hides the Instrument Panel to show only the Instrument Header. Clicking on this button again will reveal the Instrument Panel.

(3) **Instrument Name**: Displays the name of the Instrument.

(4) **Snapshot Menu**: A menu for loading Instrument Snapshots. See section 7, Snapshots and Presets for more information on Snapshots.

(5) **MIDI/OSC Indicators**: A set of 4 activity indicators, which light up whenever the Instrument sends or receives MIDI and OSC messages.

(6) **Polyphony Info**: Shows the number of voices used by the Instrument. Generally this equates to the number of notes that the Instrument can produce at once, but this may not always be the case.

The Instrument Header can contain any combination of the described controls and displays, or even not be shown at all for specific Instruments.
6.1 A/B View

REAKTOR Instruments can have two different Panel layouts, which are called the A view and the B view. Not all Instruments use this feature.

Generally the A view is the main view, featuring the main controls needed to use the instrument or effect.

The B view can be any number of things. MONARK for example uses the B view for the settings, MOLEKULAR uses the B view for a simplified interface, and KONTOUR uses the B view to display the full set of controls.

► You can select to view the A or B views by clicking on the A and B buttons in the Instrument Header.
Snapshots and Presets

Snapshots, which are REAKTOR's sound preset format, enable you to store and recall the state of your Instrument's Panel controls. When you recall a Snapshot, all the Instrument’s Panel controls are restored to the state they were in when the Snapshot was originally created.

Most pre-built Ensembles include a number of Snapshots for the included Instruments, ready to be used in your music. Each REAKTOR Instrument can store 16 Snapshot Banks containing 128 Snapshots each, for a total of 2048 Snapshots.

In this chapter you will learn how to recall and create Snapshots, as well as how to save them to an external Preset file.

For more information about Snapshots in REAKTOR, refer to the Diving Deeper document.

7.1 Recalling Snapshots

You can recall Snapshots from several locations:

- **The Snapshot menu in REAKTOR's Toolbar**: This method recalls Snapshot settings for all Instruments in an Ensemble.
• **The Instrument Header**: This method recalls Snapshot settings for this particular Instrument only.

• **The Snapshot tab in the Side Pane**: This area gives you a better overview over the available Snapshots for the selected Instrument. In Edit Mode, the Snapshot tab allows you to store and edit your own Snapshots (see section ↑7.2, Storing Snapshots).
• **Via MIDI**: REAKTOR can accept Program Change messages and use them to select Snapshots. The MIDI Program Change message selects a Snapshot by its number (an integer in the range \([0 \ldots 127]\)). A Program Change value of “0” selects the first Snapshot; a Program Change value of “1” selects the second Snapshot, and so on.

### 7.2 Storing Snapshots

Storing and editing Snapshots can be done from the Snapshots tab in the Side Pane.

- In order to be able to store and edit Snapshots, enable Edit Mode by clicking on the EDIT button in the Toolbar.

At the bottom of the Snapshot pane are three buttons for storing Snapshots:
The buttons to Add, Store, and Insert Snapshots

- **Add:** Creates a new Snapshot with the current settings of your Instrument at the end of the Snapshot list.

- **Store:** Overwrites the currently highlighted Snapshot with the current settings of your Instrument.

- **Insert:** Creates a new Snapshot with the current settings of your Instrument directly after the currently highlighted Snapshot, moving any other Snapshots down one slot in order to make space.

Snapshots are stored in the Ensemble, so you need to save the Ensemble or Instrument in order to make changes to the Snapshots permanent.
7.3 Presets

REAKTOR Preset files are a single Snapshot, saved as an external file. Presets contain a link to their original Ensemble file, which is automatically loaded as soon as the Preset file is opened.

Presets can also be saved and loaded when using REAKTOR PLAYER, or the full version of REAKTOR when in Play Mode.

► To save a preset, go to the main menu and select File > Save Preset As .... This opens a dialog window asking you choose a location and a name for the new Preset file.

► To load a preset, go to the main menu and select File > Open Preset .... This opens a dialog window asking you choose a Preset file from your hard drive to load.
8 Controlling REAKTOR

REAKTOR Instruments can be remotely controlled from a wide range of hardware controllers. This enables you to play REAKTOR with a physical interface, be it a MIDI keyboard, a special MIDI controller with knobs and buttons, or a device supporting Open Sound Control.

REAKTOR uses two protocols for sending and receiving control messages:

- **MIDI**: Musical Instrument Digital Interface - a standard communication protocol for musical instruments created in the early 80s that is still commonly used today. Virtually all keyboard controllers use MIDI to communicate with your computer. It is also used by hosts to communicate with the REAKTOR plug-in.

- **OSC**: Open Sound Control - a more modern protocol that offers faster data rates, higher resolutions, and a more flexible architecture compared to MIDI. However, OSC is less common and requires a more advanced setup.

This Getting Started document only describes basic MIDI options. Since the MIDI and OSC functionality is tied together, the following description refers to combined functions in some cases.

For more information on using the OSC protocol with REAKTOR, refer to the Diving Deeper document.

8.1 MIDI Learn

In order to be able to remotely control REAKTOR from your hardware controller, its MIDI controls need to be connected to the Panel controls in REAKTOR.

Your hardware controller has to be enabled in REAKTOR’s MIDI settings first. See section 3.2, MIDI Settings for more information.

The easiest way to connect a MIDI control to a Panel control is the MIDI learn function. It establishes the connection between the MIDI control and the Panel control in a semi-automatic fashion.
1. Right-click on the Panel control you want to connect the MIDI control to.

![Panel control with MIDI & OSC Learn menu]

2. Select *MIDI & OSC Learn* to enable the MIDI learn function.

![MIDI & OSC Learn menu]

3. Move the MIDI control you want to use.

→ The MIDI control is connected to the Panel control, which can now be remotely controlled from your MIDI controller. The MIDI learn function is disabled automatically as soon as the connection is established.

### 8.2 Connection Manager

The Connection Manager is located in the Side Pane. It allows you to manage the MIDI connections in the currently loaded Ensemble.
To view the Connection Manager, click on the Side Pane tab with the controller icon.

The Connection Manager appears in the Side Pane.

The Connection Manager has two tabs, one for **MIDI** and one for **OSC**.

When working with MIDI, select the **MIDI** tab.

All established connections are shown in the list at the top of the **MIDI** tab. They appear in the following order:
(1) **Current:** The current connections appear at the top of the list. They are identifiable by the information present in the **Target** column.

(2) **Recent:** Recently received messages appear below the current connections (by default, this list is only refreshed each time you open the tab).

Note messages appear below controller messages, both for current connections as well as for recently received messages.

► To view incoming messages in real-time, activate the **Auto** button below the list. Not only will this re-populate the list in real-time, but it will also highlight currently used messages.

► To clear any unconnected controllers from the table, click on the **Clean** button below the list.

**Creating Connections**

You can connect MIDI controls to Panel controls from the Connection Manager by drag and drop:
1. Click on the arrow icon next to the MIDI control you wish to use and keep the mouse button pressed.

2. Drag the control over the Panel control you wish to connect it to and release the mouse button.

The MIDI control is connected to the Panel control and appears among the other current connections at the top of the list.

Alternatively, you can activate the MIDI Learn function from the Connection Manager:
1. Click on the Learn button at the top right of the Connection Manager to activate MIDI Learn.

2. Click on the Panel control you want to connect the MIDI control to.

3. Move the MIDI control you want to use.

→ The MIDI control is connected to the Panel control and appears among the other current connections at the top of the list.

Deleting Connections
You can also use the Connection Manager to remove MIDI connections:
1. Select the connection you wish to remove by clicking on it in the list.

![Image of MIDI connections list]

2. Click on the Delete icon below the list or press the [delete] key on your keyboard.

![Image of MIDI connections list showing deletion action]

→ The selected connection is removed.

**Filtering the Connections List by Controller Data Type**

You can filter the MIDI connections list by the data type. The available filters are:

- **All**: All MIDI message types are shown.
- **CC**: Only MIDI CC (Continuous Controller) data is shown.
- **Note**: Only MIDI Note data is shown.
- **AT**: Only MIDI Aftertouch data is shown.
To filter the list of controller messages by data type, right-click on the Control column's header and select one of the available data type filters from the context menu.

Filtering the MIDI List by MIDI Channel

You can also filter the MIDI connections list by MIDI channel.
To filter the list of controller messages by MIDI channel, right-click on the Ch (Channel) column's header and select the MIDI channel from the context menu.

Filtering the Lists by Ensemble or Instrument

Finally, you can filter the MIDI connections list so that only controller messages assigned to a specific Ensemble or Instrument are shown:
To filter the list of controller messages by Ensemble or Instrument, right-click on the Target column's header and select the Ensemble or Instrument from the context menu.
9 Getting Deeper into REAKTOR

The present document has given you an overview over REAKTOR’s interface and functionality, and you have learned how to load and play REAKTOR instruments and effects.

To expand your knowledge about topics like Snapshots and controller integration in REAKTOR, as well as make yourself familiar with new topics like Panelsets and the Sample Map Editor, it is suggested that you read the REAKTOR 6 Diving Deeper document next.

If your goal is to build your own REAKTOR Instruments, it is still recommended that you read the Diving Deeper document before moving on to the Building in Primary document.